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Preface

Welcome to the Docmosis Template Guide. This manual is intended for document
template developers who will create richly formatted document layouts with the special
embedded features that enable Docmosis to produce documents using data generated
by Java applications.

The Docmosis Template Guide provides information on developing document templates
(in either MS Word, OpenOffice.org Writer or LibreOffice Writer) that will be used to
produce printable documents. This guide assumes a level of competence in using each
word processor and is not a reference manual for either.

OpenOffice and LibreOffice are based on the same code and can be used
interchangeably by Docmosis. In this document it can be assumed that where
OpenOffice is mentioned, the same applies to LibreOffice unless otherwise stated.

Note

Don't worry. If you are competent with only one of the two word processors, you don't have to know
how to use the other. In general the activities to develop the templates are the same for both tools but
where there are differences between the two, this document highlights them and describes the
activities for each application.

Conventions used in this guide

This document uses typographical conventions that highlight significant parts of the
text to distinguish it from normal text.

Text that looks like this... Means this...

<<fieldname>> A field in the document template. In Word it is a mail merge field.
In OpenOffice / LibreOffice Writer it is an input field.

A code instruction: either an individual line, or part of a complete
module.

docmosis. ###

I A symbol to show that the line of code has wrapped due to the
space restrictions on the page. You should remove this symbol from
your code if you copy and paste code snippets from this document.

An indicator to signify that the preceding sequence of code
instructions will execute incrementally until there is no more data in
the data provider.

template.doc A file name, a file extension or a Web site address.

Table 1: Typographical conventions

Additionally, some parts of the document are written specifically for one of the word
processors mentioned. When this is the case, the paragraph has the respective icon in
the left margin.
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This icon... Means this...

@j

The information applies to MS Word only.

=,

The information applies to OpenOffice.org Writer and LibreOffice
Writer.

Table 2: Graphical conventions

Special paragraphs

In addition to the text conventions, certain information is presented in a specific way
to emphasise their information.

Note

A note provides additional supporting information that will help you to understand a point that the

author is trying to make.

Important

Tip

General Terminology

Executed code on a computer rarely cause damage to hardware but may well corrupt data.
Information in this form is intended to alert you to the potential for data corruption.

A tip provides anecdotal information to support the technical information about using the system and
might be useful in helping you understand the information being presented.

Several terms are used in this document to identify elements of a document template.
The following table provides definitions for those terms. Note that the definitions are
general: for more details on these terms, you should refer to the online Help for the
particular word processor with which you are developing the templates.

This term...

describes this document element...

field a placeholder that is used by Docmosis to substitute data or control
document flow
boilerplate graphical and textual content that is added to a template as reusable

content to avoid having the document developer recreate the content
for each document. Docmosis uses boilerplate components.

header and footer

elements of a printed document that repeat on every page.
Information in these elements is usually administrative information

about the document.

Table 3: Document terminology
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.: Preface

1 Introduction

Docmosis is an easy-to-use document processor which integrates with your Java application
to provide the seamless production of printable documents using data generated by the
application.

The documents are produced in one or more of the following formats: MS Word; Open Office
Writer; LibreOffice Writer; Adobe PDF and HTML using your custom-made templates.
Docmosis delivers a great reporting engine by providing the following:

e cross platform compatibility;
e portability;
e scalability.

In this chapter, we provide information about the main features of a Docmosis template.
Details for incorporating elements and Docmosis logic structures into a template are
provided in Chapter 2, Developing Docmosis templates.

1.1 Separating content from presentation

Developing applications that contain presentation logic means that when an organisation’s
brand image changes (such as a new company logo, different corporate font or company
name), so must all the applications. Using Docmosis, all of your presentational features are
developed separately from your application in commonly used word processors. This has two
distinct benefits:

e The initial development of the document templates can be assigned to those who are
experts in that field and they can be developed using one of the two most commonly
used word processors; and

e Branding changes do not require software development support, which can be time
consuming and expensive.

In addition to these benefits, Docmosis is fast: the core document processor can produce
hundreds of documents in minutes in the most popular formats, which is a great
improvement on other document processors currently available.

1.2 What are templates?

As far as Docmosis is concerned, templates are typical MS Word or OpenOffice.org Writer
documents that may also contain fields. Docmosis uses fields to insert data, and mark the
start and end of content for exclusion or repetition. Fields are standard features of these
two document tools meaning Docmosis does not require any custom plugins. Docmosis
supports a wide range of versions (MS Word 97 onwards, OpenOffice.org Writer 2.2
onwards).
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As well as using fields to drive Docmosis, templates in MS Word and
OpenOffice.org/LibreOffice Writer give ideal control over aspects such as:

e page size, margins, and columns;

e information in running headers and footers;

e typographic characteristics that describe paragraph and character styles; and
e boilerplate text, graphics and embedded field codes.

Documents created using a template inherit this pattern when they are created and no
programmatic effort at all is required to benefit from these features. Once the document
is rendered, it has no connection to the template from which it came other than that it is
based on its characteristics. Templates can be modified as required without any concern
to the documents that have been rendered in the past.

Tip

In addition, as the paragraph and character patterns for the output are described in simple
formatting terms, there is no real need to develop paragraph and character styles. However, if you
are comfortable using styles, it might be advantageous to implement them for future template
updates.

1.3 Where are the templates stored?

You can provide your templates to Docmosis in many different ways: from directories,
files or Jar files (or if you are a developer, from any InputStream). Docmosis manages a
“store” of its own templates, which acts as a cache for the templates. The cache enables
Docmosis to analyse the template and to optimise it for later rendering. For more
information about registering templates, refer to the Docmosis Developer’s Reference.

1.4 How does document generation work?

In the simplest terms, Docmosis seamlessly integrates the data available in the
application with the element structures in the template to produce documents that may
be:

e stored electronically, printed, viewed or any combination of these; and
e published in several document formats.

During document generation, Docmosis loads the template from the template store,
merges it with data and creates the resulting document in the desired format(s). Data
can be sourced from any combination of locations (databases, files, Java Objects etc),
templates can include/exclude any content, tables can grow and shrink and images can
be embedded. These features are discussed later in this guide.

If the template document includes an index or table of contents, Docmosis will
automatically update these tables in the resulting document.
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.: Preface

1.5 Template features

Modern word processors enable the development of documents with support for high-
quality typesetting and layouts incorporating inline images. By inheriting these features
automatically, Docmosis provides the developer and template author with an extremely
powerful automatic document generation capability. Other aspects of the document that
are relevant to Docmosis are detailed in this section.

In this section:

e General features. Information about the general document features that can be
used to create and exploit to deliver high-quality layouts;

e Advanced features. Details on the Docmosis features that can be incorporated into
your template; and

o Docmosis elements. Details of the Docmosis elements that interact with the
document generation process.

1.5.1 General features

Many of the integration aspects are achieved simply by using well known documentation
techniques. Docmosis understands elements such as lists and tables, so there is no need
to learn new techniques to develop templates for use with Docmosis.

The general aspects of a document template include the creation of branding features,
layout features and static text elements. In order to create a document template for use
with Docmosis, the template author can simply create a document and direct Docmosis
using the following features in your word processor:

Word Feature Writer Feature Controls
Plain text markup Plain text markup Data insertion and document flow
Mail merge fields Input fields Data insertion and document flow
Bookmarks Image properties Image insertion

1.5.2 Advanced features

To generate sophisticated documents of value to your application, fields are interpreted
by Docmosis. These fields can direct Docmosis providing:

e Insertion of text or image data into the body, headers and footers and tables;
e Inclusion or exclusion of static or dynamic content;

e Hyperlink Insertion;

e Repeating of content;

e Table row repetition or exclusion;

e Table column removal;
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e Numbered and bullet list expansion;

e Template merging

1.5.3 Docmosis elements

All Docmosis “elements” are controlled by fields, except for image insertion which is

controlled by bookmarks or image properties. Each element is discussed in detail in this
guide. In general, elements may be singular (such as a text insertion) or may be paired
having a start and end marker.

1.5.3.1 Field Reference

The following table provides a quick reference to the elements and their syntax. The
names of the fields must match exactly for the document generation to succeed.

Element

<<name>>

Description

Replace this field by whatever data is referenced by
“name”.

Closing Element

<<link name>>

Insert a hyperlink at this location, looking up the URL from
the data under the key "name". The URL can optionally
specify display text other than the URL to be used with the
form: <display text>|<url>. eg "mySite|
http://www.my.com"

<<$abc=name>>

<<$abc=10.2>>
<<$abc='Fred'>>
<<S$abc=true>>
<<$abc=null>>

Lookup the data associated with “name” and assign it to
the variable “abc”.

Assign the number 10.2 to variable $abc
Assign the string "Fred" to variable $abc
Assign the boolean true to variable $abc
Assign the value null to variable $abc

<<$Sabc>>

Lookup the variable “abc” and render its value

<<cs name>>
<<cs {expr}>>
<<cs_Sabc>>

All content up to the closing element is included or
excluded depending on the value associated with “name”
or the expression “expr” or the variable “abc”.

<<es name>>
<<es {expr}>>
<<es_ S$Sabc>>
<Les >>

<<rs_name>>
<<rs_S$Sabc>>

<<rs people:step
2>>

<<rs people:step
2down>>

All content up to the closing element is repeated whilst
there is data associated with “name” or the variable “abc”.

“stepN” indicates that the data (“people”) should be
iterated in steps of N size. When stepping is used,
variables $i1, $i2,...$iN are automatically created to access
the items available in each step.

“stepNdown” indicates that the data (“people”) should be
iterated in steps of N size and data should be presented in
a “down”-ward manner. Variables $i1, $i2,... $iN are
automatically created.

<<es_name>>
<<es_ Sabc>>

<<es people:s
tep2>> or
<<es >>

<<cr_name>>
<<cr_ {expr}>>
<<cr_sSabc>>

Include the following table rows depending on the value
associated with “name” or expression “expr” or the variable
\\abcll.

<<er name>>
<<er {expri}>>
<<er_Sabc>>
<<er >>

Docmosis Template Guide
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Element

<<rr7name>>
<<rr Sabc>>

<<rr people:step
2>>

Description

Repeat the following table rows whilst there is data
associated with “name” or the variable “abc”.

“stepN” indicates that the data (“people”) should be
iterated in steps of N size. When stepping is used,
variables $i1, $i2,...$iN are automatically created to access
the items available in each step.

Preface

Closing Element

<<er7name>>
<<er S$Sabc>>
<<er >>

<<cc_name>>
<<cc_{expr}>>
<<cc Sabc>>

Include or exclude the table column containing this field
depending on the value associated with “name” or the
expression “expr” or the variable “abc”.

Image bookmarked
with label or named
“img name”
(deprecated

"bm name")

Replace the image with the image data associated with

“name” using the default scaling settings (which is stretch).

The default setting can be changed by setting the
docmosis property
docmosis.analyzer.image.scaling.default
to fit or stretch.

See the Docmosis Developer's Reference for information
about setting properties.

Image bookmarked
with label or named
“imgstretch name

”

Replace the image with the image data associated with
“name” and stretch the image to match the template
image placeholder.

Image bookmarked
with label or named
“imgfit name”

Replace the image with the image data associated with
“name” and fit the image into the template image
placeholder whilst preserving the image aspect ratio.

<<ref:subl.doc>>

Insert the template subl.doc at this location.

<<refLookup:subl
>>

Lookup sub1l in the data to get the name of the template
to insert at this location.

Table 4: Docmosis element quick reference

Note

Care must be taken with all fields when using MS Word documents as templates. You MUST AVOID
SPACES in a field name as a space will truncate the field and sometimes Docmosis will not be able to
detect this. The good news is that most of the time this will turn up as an obvious error reported

during document generation.

1.5.3.2 Expressions

Docmosis uses { and } to delimit an expression to be evaluated. The following table

shows examples of valid expressions that Docmosis supports. The examples are for a
conditional section (“cs_") but apply to conditional columns (cc_) and rows (cr_) in tables

also.

Element Description

<<cs_{a<10}>>

Lookup data element “a” and see if it is less than 10 numerically. If “a” is not

numeric, a string comparison is performed automatically.

<<cs {a='fred'}>>

Lookup data element “a” and see if it is equal to the String literal “fred”.

<<cs_{$al=10}>>

Lookup the variable “a” and see if it is not equal to the numeric value 10. If

variable “a” does not resolve to a numeric value, a String comparison is

performed.
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Element Description

<<cs_{! Lookup the data element “hasElements()” and boolean negate the result. If
hasElements() }>> hasElements() returns something other than a boolean, the result will be
evaluated using a best effort (eg a String value of “true” would resolve to
true). Note that the use of the brackets “( )" typically implies the data is to be
sourced by calling a Java function literally.

<<cs_{a=null}>> Lookup the data element “a” and determine if it's value is null

<<cs_{$a}>> Determine if the value of the template variable $a is true

Other operators include

=~ Less than or equal to

Greater than or equal to

>=

1.5.3.3 Nesting

Elements can be “nested” with regards to the way they lookup data. For example,
<<hotel.floor>> typically would refer to the floor within a hotel object. The period *.”
character represents the delimiter between one level of data and the next. This is
described in detail later.

1.5.3.4 Range Specifiers

Data elements can also be referenced by ranges of values Docmosis should lookup. This
provides a fair amount of power within the template to select the values of interest. It
depends on the context of the element as to whether it is allowed to produce multiple
values (and Docmosis will flag errors where inappropriate use is made). For example, a
repeating section is expected to produce multiple values, but a simple lookup field is not.

The following table details the types of range specifier available.

Element Description

<<hotel[0]>> The first hotel (indexing starts at zero)

<<hotel[F]>> The first hotel (equivalent to index zero)

<<hotel[L]>> The last hotel

<<hotel[*]>> All hotels

<<hotel[F3]>> The first 3 hotels

<<hotel[L3]>> The Last 3 hotels

<<hotel[1,2,4]>> The hotels at indexes 1,2 and 4

<<hotel[1-3,L.2]>> The hotels at indexes 1 to 3 inclusive and the last 2
<<hotel[0-L2]>> All but the last 2 hotels

<<hotel[3].floor[L].room[0].name>> | The name of the first room of the last floor of the hotel at index 3

1.5.3.5 Built-In Variables

Docmosis provides some built-in variables to assist with common data lookup
requirements.

Variable Description
<<S$top>> The root of the data regardless of the current position or context
or <<S$root>> in the template
Page xii Docmosis Template Guide
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d.

Variable Description

<<$this>>

or <<$current>>

Preface

The current source of data in the current position in the template.
This allows for anonymous data lookups from arrays or collections
such as <<$current[0]>>.

<<$parent>>

The parent or container of data in the current context of the
template. Allows data lookup in the current “hotel” when the
current context is a “floor” for example.

<<$idx>>

The current index when iterating through a data set. For example,
if we are repeating over all hotels, $idx would report the index of
the hotel we are up to. Note that <<$rowidx>> is the same
unless using a step size greater than 1.

<<S$itemnum>>

Similar to $idx but is the number of the item which we are
currently addressing. Item numbering starts at 1. Note that
<<$rownum>> is the same unless using a step size greater than
1.

<<$size>>

The size of the current repeating data set. For example if we are
repeating over all hotels, $size would be the number of hotels.

<<$i1>>,<<§i2>>, <<GiN>>

References to the Nth item when repeating data in "steps of N".
For example <<rs_people:step3>> steps through the people in
"steps of 3" and Docmosis automatically creates variables $il, $i2
and $i3 to access each element in the step.

For more information about the use of "steps of N" see sections
2.8 Repeating sections (page 25) and 2.9.2 Repeating rows (page
30).

<<$idx >>,<<$idx2>>,. <<$idxN>>

The absolute indexes of the items when repeating with "steps of
N" (as described above) starting at zero.

<<$itemnum1>><<§itemnum2>>, ...

The absolute indexes of the items when repeating with "steps of

<<$itemnumN>> N" (as described above) starting at one.

<<$rownum>> The current row number (starting at 1) when repeating (either
repeating rows or repeating sections). This is most useful when
using the “stepping” directives and the $itemnum is not suitable.

<<$rowidx>> The current row number (starting at 0) when repeating (either
repeating rows or repeating sections). This is most useful when
using the “stepping” directives and the $idx is not suitable.

Note

Variables can also be referenced using var instead of $. This means <<$name>> is equivalent
to <<var name>>. This is particularly useful for bookmarking images using variables in MS Word,
where you cannot use the $ symbol in the bookmark name.

1.5.3.6 Error Handling

Docmosis offers two ways to deal with errors encountered in templates during processing:

1. write the error INTO the resulting document - errors are highlighted and footnotes are
added to offer details and suggestions as appropriate

2. throw an exception and abort document production

Version 3.2
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This behaviour is property controlled since it is expected to be related to the type of
environment in which Docmosis is running. The default behaviour is write errors into the

document, but this is not always advisable. See the Docmosis Developer's Reference for
more information.
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2 Developing Docmosis templates

The basic steps for developing a template are:
1. create the layout, boilerplate content and typesetting characteristics of a document;
2. incorporate the Docmosis elements (fields).

The boilerplate content can include sophisticated structures using headings, lists, tables,
images, and headers and footers.

Tip
Q When creating a template, use the word processor of your choice from the two identified.

This chapter provides instructions for the inclusion of the supported fields; it is divided into
sections that discuss the basic aspects through to some advanced techniques. In general,
the information does not cover typesetting of documents but does provide information where
necessary. Most of the information in this chapter is relevant to both word processors: where
they differ, information is provided for each case.

Important

All the procedures in this chapter assume that you understand the techniques required for the
particular word processor and that you have a document open in the word processor on which you can
perform the procedure.

In addition, the procedures use menu-based instructions for consistency.

2.1 Incorporating Docmosis elements

You can add Docmosis "fields" at any location in a document template. Each field must have
an appropriate property name that identifies it and associates it with an element of the data
generated by Docmosis. During document generation, Docmosis expects the application to
provide values and logical data structures with the same names and structure as the
elements that exist in the template.

Docmosis supports fields using:
e plain text mark-up
¢ Merge Fields in MS Word
e Input Fields in Open Office Writer or Libre Office Writer

Plain text mark-up is the simplest to use since there are no dialogs to interact with and what
you see is what you get. With both Word and Writer, a field (Merge Field or Input Field) can
have a different value displayed to what it represents "behind the scenes".

Docmosis Template Guide Page 15
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2.2 Using Plain Text Mark-Up

Plain text mark-up is the easiest method of creating fields in Docmosis templates. By
default, the start of a field is annotated by << and the end of a field by >>. So to create a
field that looks up "personName", you would simply type <<personName>> into the
document.

So as to be as unobtrusive as possible to the text of a template, Docmosis is strict about
identifying plain text fields and will ignore invalid mark-up assuming it is plain text. For
example, <<personName> Will be ignored and left as plain text because a closing ">"
character is missing. A single space between the << and the name or the name and >> is
allowed, but more spaces will also mean the field is not recognised. The following table
shows the typical types of error that will result in a field not being recognised.

Example Field Valid Problem
<<personName>> <<personName>> Correct field. Docmosis will identify and substitute.
<<personName> <<personName> MBQngtm”W@ >
<personName>> <personName>> Missing leading <

<< personName>>

<< personName>>

2 spaces after leading <<

<<personName >>

<<personName >>

2 spaces before trailing >>

< <personName>>

< <personName>>

Space after leading <

<<personName> >

<<personName> >

Space before trailing >

Plain text mark-up is controlled by the properties:

Property Default Description
docmosis.analyzer.field.plainText.prefix << Start of field delimiter
docmosis.analyzer.field.plainText.suffix << End of field delimiter

The plain text mark-up settings can be changed or disabled on a case by case basis using features of
the DocumentProcessor class. For more information about setting Docmosis properties, please
see the Docmosis Developer's Reference.

2.3 Using Document Fields As Mark-Up

Docmosis also supports the use of the "document fields" supplied by the Word and Writer
word processors such as merge fields and input fields.

The advantages of using these document fields include:

1. you can display text that is different from the actual field codes for docmosis. For example
the following field appears as:
«friends»
but may in fact represent:
«friends[0].lookupName»
so it appears smaller or more succinct in the document.
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2. a logical separation of content and control/mark-up. It is clear to both users and the
Docmosis engine what is plain content and what is Docmosis mark-up.

The disadvantages of using document fields include:
3. afield can be confusing or misleading because it's true lookup value is hidden

4. more effort is required to work with these fields via popup dialogs or switching field
codes on and off

5. with Word merge fields the "display" value can be accidently lost (replaced with the
underlying lookup value) if the fields in the document are "updated"

6. the latest versions of Word make it difficult to simply insert a merge field, trying to guide
the user to link up to a data source. The options are to user plain text fields, type the
field codes manually, or copy a merge field from another document then edit it to what
you require.

The following sections describe how to insert document fields using the features of Word
and Writer.

2.3.1 About MS Word versions

In general, the procedures to implement the Docmosis features into templates are consistent
in all versions of MS Word. However, the layout of the Field dialog box has changed over the
years. The following illustrations show the dialog box layouts for the different versions and
identifies the areas that are relevant to Docmosis templates.

The Categories list in The Categories list in
Word 97 and 2000. Word XP (2002) onwards.
21X

Cateqaries: Field 8

Al e Plesse chooss a fisly Field properties Fisld optons

LAl Categories: Field name:

Date and Time

Document Adtomation Mail Merge v| | |Firstiame [ Text to be inserted

Document Information before:

Equations and Formulas Eield names: Forma: [ Text to be inserted after:

[ndex and Tables AdaressBlock

Links and References Ask Uppercase [ Mapped field

Mumbering CWT]E’E Lowercase
Database First capital

User Information Fil-in Title caspe Flesis s

Field codes:  MERGEFIELD Fieldhame IGfrEEﬁngLine
MergeField

[VERGEFIELD Firstiiame MergeRec

Description ms;%ESEq

Insert a mail merge field Mextif
Set

[V pressrve formatting during updatss SkipIf

ok | canedl | oprions. | Descriptian:
Insert a mail merge field
Preserye formatting during updates
The Field names list in
Word 97 and 2000.

The Field names list in
Word XP (2002) onwards.
The Field dialog box layouts in different versions of MS Word

Newer versions of Word (from 2007) make it difficult to insert a merge field manually. Your
options include:

1. use plain text mark-up instead of document fields
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2. copy a merge-field from another document then edit it

3. turn field-codes on and manually construct a field. Please refer to Word's help for details
about manually entering field codes.

2.3.2 To Insert A Field Using MS Word

This section describes how to insert a document field. It is generally simpler to use plain
text mark-up as described in section 2.2 Using Plain Text Mark-Up.

To insert a field that will look up a value for "firstName":
|f£|j For versions prior to Word 2007:
Position the insertion point at the location for the field.
Select Insert > Field.
In the Field dialog box, select Mail Merge from the Categories list.
Select MergeField from the Field names list.
Type firstName into the appropriate field (see About MS Word versions earlier).

Click OK.

o A w N

dialog box. You may change the text that is displayed without changing the title of the merge
field. Simply edit the text that appears between the angle brackets. Be warned though that this
is generally not a good idea because if anyone updates the field codes in the document, the
“display” name will be reverted back to the real contents.

Tip
@ By default, MS Word displays the same text in the merge field as the title you enter in the Field

Tip

In MS Word documents it is a good idea to frequently ensure the merge fields are displaying
what they actually are going to look up. This can be achieved by selecting the fields (or the
whole document) and pressing F9 (update field codes).

For versions from Word 2007:
1. Copy the field from another document and then edit

The reasons for the above limitation are described in 2.3.1 About MS Word versions.

2.3.3 To Insert A Field Using Open Office / Libre Office Writer

-:" This section describes how to insert a document field. It is generally simpler to use plain
=1 text mark-up as described in section 2.2 Using Plain Text Mark-Up.

To insert a field that will look up a value for "firstName":
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Position the insertion point at the location for the field.
Select Insert > Fields > Other.

In the Fields dialog box, select the Functions tab.
Select Input Field from the Type list.

Type firstName into the Reference field.

Click Insert.

N o s W DN =

When the Input Fields dialog box prompts you, in the field below the one that contains
the field reference, type the text that you want to be displayed in the document to
identify the field. Keeping this text consistent with the text in the Reference is a good
idea since it can avoid mix-ups.

Note

OpenOffice.org Writer presents the field information differently from MS Word: OpenOffice.org Writer
does not insert a pair of angled brackets («...») around the displayed field text. You can hover your
mouse cursor over the field to see the “real” value that will be used by Docmosis to lookup the data.
Another easy way to access the "real" value is to right click on the field and select "Fields".

8. Click OK.
9. To close the Input Fields dialog box, click Close.

Note

When inserting fields in OpenOffice Writer you may choose to leave the field dialog open whilst you
work and whenever you need to add a field, you simply go to the dialog and start adding it. Also, note
that ctrl-F2 is a shortcut to the Fields dialog.

2.4 Basic text elements

Docmosis supports the inclusion of elements that simply match an element of data that is
output by the application (essentially, this is a one-to-one match). Wherever an element
occurs, Docmosis will substitute the actual data value in the document. The inserted data
inherits all the typesetting characteristics that are applied to the field such as font and
paragraph style. The syntax for a text field is:

<<element-name>>

To populate the template element, the Docmosis engine would attempt to source data by
the name of the element. A field designed to look up data for "firstName" would appear in
different ways depending on how you create the field:

Field Appearance

Plain Text Field <<firstName>>

Word Merge Field | «firstName»

Writer Input Field | firstName
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Docmosis will replace the field with all the text supplied as if you had selected and typed over the field
by hand. If the lookup data contains new-line characters, Docmosis will create new paragraphs in the
resulting document. If there is no lookup data for the name, the field is removed.

Docmosis Template Guide

2.5 Images

Docmosis is able to insert images at arbitrary locations in documents. Instead of using fields
to identify the location for an image substitution, Docmosis uses the word processor’s image
handling features. By handling images this way, the template can precisely define how the
image will be placed and bordered within the resulting document. As each word processor
works slightly differently, there are specific methods for setting up the Docmosis code
element:

e In MS Word Docmosis uses the bookmarks feature to identify a name for an image; and

e OpenOffice.org Writer supports the identification of images directly, using a Name
property.

Staff Profiles

Please contact any of our friendly and experienced staff for more information about your

svstem solution.
IDSets

Name:
Position: «f
Tel tele
Email: «ema

Summary:

In MS Word, bookmarks
identify images.

s IDSets

Images can be placed anywhere in a Docmosis template.

Note
In the preceding example, a borderless table is used for layout purposes.

Tip

This activity doesn't discuss the actual images that you will publish, only the placeholder image. You
may create and use your own image but for your convenience, a placeholder image is provided as
part of the Docmosis distribution.

You are free to use it without restriction.

I@j Use only inline images in MS Word

Docmosis cannot support floating images in MS Word because it uses the bookmarks feature
to assign a name an image placeholder. When you position an image using the floating
position settings, MS Word removes the bookmark. There are other limitations to how
Docmosis supports images, particularly in terms of overlapping with text and other images.
This generally will not cause issues for typical documents.
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Image file size

When you insert a placeholder image, you will embed the image in the document. This
means there is a copy of the image at every location in which it is placed (not simply a
single, referenced copy). To limit the overall size of the template file and to improve the
performance of a document generation, you should use relatively simple and small
placeholder images to identify the locations without compromising on print-quality if the
document is to be printed.

Image placeholder naming convention

Image placeholder names are identified using special prefixes. These prefixes are a useful
way to distinguish those items that are specific to your Docmosis application and enable you
to use the bookmarking and naming features for other items that aren’t part of a document
generation.

The prefixes you can use are:

Prefix Example Effect

The image is substituted with the supplied imagel and
default scaling is applied. The default scaling is "stretch"
and may be changed by Docmosis properties or by
parameters when rendering the document.

img_ img imagel

The image is substituted with the supplied imagel and
stretch scaling is always applied. The image is stretched
to be the same size and shape as the place holder image
in the template.

imgstretch_ | imgstretch imagel

. The image is substituted with the supplied imagel and
imgfit imgfit_imagel the image will be scaled to fit the template placeholder

whilst preserving imagel's aspect ratio.

Note
Docmosis previously used "bm_" instead of "img_". The "bm_" prefix is still valid and is synonymous
with "img_" but it's use is deprecated and future versions of Docmosis may remove support for it.

In the following procedures, an image is inserted as a place holder in the template to be
substituted for image data identified by "image1".
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To insert an image element (MS Word):

ﬂ—lj 1. Position the insertion point at the location of the image.

2. Select Insert > Picture > From File.

3. In the Insert Picture dialog box, navigate to the location of the placeholder image and
select it in the list of files.

4. C(Click Insert.

5. When the image appears in the document, select it and use the reshaping handles to
adjust the dimensions of the image.

6. Make sure that the image is selected and click Insert > Bookmark.

7. In the Bookmark dialog box, type img imagel into the Bookmark name field.

8. Click Add.

Tip
MS Word wraps the content of the bookmark in light-coloured square brackets. To see the bookmark
in place, set the Bookmarks option in the MS Word Options dialog box.

Tip
MS Word Bookmarks names can't contain "$" characters. To use a Docmosis variable in a bookmark
name use "var_" instead of "$", for example "var_myVar" instead of "$myVar".

Tip

MS Word Bookmarks names can't contain "." characters, so it cannot directly use "nested" lookups
(eg person[0].photo). You can use Docmosis variables to overcome this in conjunction with the tip
above about referencing variables in bookmarks.

eg <<$myImage=person[0].photo>> in your template body to set the variable
and "img_var_myImage" as the book mark name to link the image data to the template image.

=W To insert an image element (OpenOffice.org Writer):
=1 1. Position the insertion point at the location of the image.
2. Select Insert > Picture > From File.

3. Inthe Insert picture dialog box, navigate to the location of the placeholder image and
select it in the list of files.

4. Click Open.

5. When the image appears in the document, select it and use the reshaping handles to
adjust the dimensions of the image.

6. Make sure that the image is selected and click Format > Picture.
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7. In the Picture dialog box, select the Options tab.

8. Type img imagel into the Name field.
9. Click OK.

Both bookmark names and image names must be unique in your template since both Word
and Writer force the name to be unique. If you wish to reference the same image in your
template multiple times, you will have to provide different names by which the image can be
referenced.

2.6 Active Hyperlinks

Docmosis allows you to insert a hyperlink dynamically into your document. In your
template, a particular naming convention identifies fields you would like to work as
hyperlinks.

To create a hyperlink, insert a field starting with "1ink ". For example, the following field:
<<link_myWebSpace>>

will act as a hyperlink looking up data for mywebSpace in your data. If your data has a
value http://www.docmosis.com for myWebSpace, then a hyperlink to
http://www.docmosis.com Will appear in your rendered document.

You may also wish to make the displayed text for your hyperlink different from the actual
URL of the link. Using the above example, to display DOCMOSIS instead of
http.//www.docmosis.com for the link in the final document, the data can provide a value
DOCMOSIS |http://www.docmosis.com. The pipe (|) symbol separates the display
name from the actual link.

2.7 Conditional sections

Conditional content is content in that will be populated in the final document depending
upon the data that is generated by the application. If the specified condition is met, the
content within the matching conditional section is rendered in the document.

An example of the application of conditional content might be in a product description such
as that for a motor vehicle in the following illustration.
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The specifications described here are fictious.
| This condition returns the

Vehicle Spegifications metric specifications.
«CS_metricy

Length: «metricLength» mm

Width: ametricWidth» mm

Engine: (V8) «metricEngine» 1

Fuel tank capacity:  «metricFuel» 1
«es_metricy
«cs_imperialy»

| This condition returns the
imperial specifications.

Length: «imperiall ength» in
Width: wimperial Width» in
Engine: (V8) «imperialEngine» cu in

Fuel tank capacity:  «imperialFuels gal
«es_imperial»

An example of conditional sections in a Docmosis template.

The conditional sections will render the data that is appropriate for each condition. That is,
each document will be generated with either metric or imperial specifications but not both.
Each conditional section is defined using a pair of fields: a start field and an end field. The
general syntax for a conditional section is:

<<cs_condition-name>>
The text and elements of the conditional section.
<<es_condition-name>> or simply <<es >>

Conditional sections can use expressions, variables and range specifiers. See the tables in 1.5.3
Docmosis elements for more information.

The conditional start and end tags are removed from the resulting document and if each tag is on a line
by itself, the entire line will be removed.

To create a conditional section:

1. Position the insertion point in an empty paragraph at the starting location of the
conditional section.

2. Insert the opening condition element into the empty paragraph.

3. Add the boilerplate content and other Docmosis elements into the subsequent
paragraphs in the document.

4. Insert the closing condition element into an empty paragraph following the conditional
content.

5. Repeat steps 1 through 4 for as many conditions as there are in your application.
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2.8 Repeating sections

In a document, a repeating section is a group of elements in succession whose content
changes but whose format is the same. Docmosis supports several forms of repeating
sections: block-level, tables and lists.

Note

Tables and lists are special forms of repeating sections. They are discussed after this section that deals
specifically with block-level repeating sections.

There might be occasions when you want to include repeating sections but do not want to
use tables and lists (bulleted or numbered) to present them. In this case you use the
Docmosis repeating section elements. Repeating sections can contain any content desired,
and it will be repeated whilst there is data to be displayed.

The example below shows a repeating section named IDSets, and it contains a table with
an image and textual data. This table will be repeated as many times as there is data
associated with IDsets.

Staff Profiles

Please contact any of our friendlv and experienced staff for more information about vour
svstem solution.

wrs_IDSetsy

Name: «name:»
Position: «position=
Tel: «telephones

Email: «emai» Repeating sections
have a pair of
Summary: containing elements.

«profileSummanry:

wes_IDSets»

Repeating sections also contain boilerplate content and other Docmosis elements.
The general syntax for a repeating section is:
<<rs_repeating-section-name>>

The text and elements of the repeating section.
<<es_repeating-section-name>> or simply

Repeating sections can be “nested” inside other repeating sections to any depth desired. Repeating
sections can use variables and range specifiers as appropriate. See the tables in 1.5.3 Docmosis
elements for more information.

The repeating start and end tags are removed from the resulting document and if each tag is on a line
by itself, the entire line will be removed.
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To create a repeating section:

1. Position the insertion point in an empty paragraph at the starting location of the
repeating section.

2. Insert the opening repeating section element into the empty paragraph.

3. Add the boilerplate content and other Docmosis elements into the subsequent
paragraphs in the document.

4. Insert the closing element into an empty paragraph following the repeated content.

Repeating sections also provide access to some built-in variables such as $idx which is the
current count of the number of times the loop has been repeated starting from zero. For,
given 4 "people" in an array <<$idx>> can be used as a index as follows:

<<rs_people>>
<<$idx>>. <<$name>>
<<es_people>>

To produce output that might look like this:

0. James
1. Jenny
2. Julie

whereas using <<$itemnum>> instead would result in:

1. James
2. Jenny
3. Julie

2.8.1 "Stepping Across" in Repeating Sections

Docmosis supports the concept of repeating in "steps". Say for example you have a simple
array of people objects in your data, and you need to place this on the page in a 3-across
layout:

James Jenny Julie

Katie Kim Kerry

the "stepping" allows you to do this in the template as follows:
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"Step 3" directive
Automatic $i1, $i2 and $i3 variables

<<rs_people:step3=>—
<<8il flame>> <<$i2.name>> <<$i3.name>=
<<er_people=>

The ":step3" directive tells Docmosis that we want to move through the "people" data in
steps of 3. Docmosis automatically creates the $i1, $i2 and $i3 variables for you to use
corresponding to the first, second and third elements. For the second row, $i1, $i2 and $i3
will correspond to the fourth, fifth and sixth elements and so on.

Docmosis will automatically create the variables required corresponding to the step being
used. In the case of "step10Q", variables $i1, $i2,... $i10 will exist.

If you need a 4-across layout instead, this is easily changed in the template by using
":step4" and adding the 4th column in your template to layout as you require:

<<rr people:stepd=>

<<8$il.name>> <<$i2 name>=> <<8$i3.name>=> <<$i4 name>>

<<er_people>>

and the resulting document (using the same data) would look as follows:

James Jenny Julie Katie

Kim Kerry

The $i1, $i2 etc. automatic variables correspond to the elements in the data provided under
the "people" key. The example above assumes that each object in the "people" data has at
least a "name" attribute and an image to display. Though you can't see it from the example,
each of the images also has a template-setting to indicate where the images come from. In
Word templates, this would be a bookmark and in Open Office Writer, this would be the
image name (see section 2.5 Images for more information about inserting images).
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Note

The examples here use the repeating rows (<<rr_>>) directive, but the stepping directives also apply
to repeating sections (<<rs_>>).

Docmosis also creates $idx1, $idx2... and $itemnum1, $itemnum?2... variables which relate to
the $i1, $i2... variables. The $idx1, $idx2.. variables provide the absolute index into the data
starting at zero (ie 0,1,2,3,4,5...). The $itemnum1, $itemnum2... variables provide the
absolute index starting at one (ie 1,2,3,4,5,6...).

2.8.2 "Stepping Down" in Repeating Sections

In the same way Docmosis can present your data in groups of 2, 3, 4 etc across a page, it
can also create groups of 2, 3, 4 etc but moving down the page instead. This means that
Docmosis will poplulate down columni, then down column 2, column3 and finally column 4.
Docmosis will automatically balance the data into the right number of rows.

Given the above example where we have four columns, but we wish to show the data down
the columns rather than across the template and the result would look as follows. Notice in
the template the “step4down” directive:

<<1r_people:step4ddown>
<<$il.name=>> <=$i2 name>> <<$i3 name>> <=$i4 name>>

<<ler_people=>

And in the resulting document, notice that James is followed by Jenny underneath. The next
element (Julie) is displayed at the top of column 2 and so on:

James Julie Kim Kerry

Jenny Katie

The “step” functions allow the template to control more of the presentation options given the
same set of data. Note that although the examples above are shown in tables since that is
often a good way to present the data, the same concepts applie to repeating sections.
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2.9 Tables

Using fairly simple table markup, you can create sophisticated table layouts in your output
documents. In addition to being able to insert text and images using the methods already
described, you can use the table-specific Docmosis elements to control:

e including or excluding of groups of rows;
e repeating groups of rows;

e removing columns.

2.9.1 Conditional rows

A set of consecutive rows can be removed from a table using conditional row elements. The
following example uses the <<cr hasFriends>> and <<er hasFriends>> elements to indicate a
group of rows in a table that should be excluded if there are no friends.

Circle of Friends

wee hasFriendss

Jimmy has some fi=nds

wer hasFriendss

In this case, if the data indicates that hasFriends is true then the row containing “Jimmy has
some friends” would be left in the resulting document, otherwise it would be removed. In all
cases, the rows containing the markers <<cr_hasFriends>> and <<er_hasFriends>> will be

removed:

Cirele of Friends

TIimmy has some friends
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Note

End markers for conditional rows can also be defined without the name. In the above example, the
field <<er hasFriends>> could also be simplified to <<er >>.

2.9.2 Repeating rows

Rows of a table can be repeated whilst there is data to repeat. The following example will
list of all the friends of Jimmy using one row for each friend showing their name in one
column and job in another.

The following example uses the <<rr_friends>> and <<er_friends>> elements to indicate a
group of rows in a table that should be excluded if there are no friends.

Circle of Friends

Friend Job
arr frendsz
TIimmy has a friend called afriends afriendlobn
aer_friendsy

In this case, while the data can supply information for friends the row containing the lookup
friend information will be rendered. In all cases, the rows containing the markers
<<rr_friends>> and <<er_friends>> will be removed.

Circle of Friends
Friend Job
limmy has a friend called Dave Marketing Manager
lNimmy has a friend called Dee 124+ Dieweloper
Wimmy has a friend called Pete Foof Tiler
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2.9.3 Alternating Row Colours and Border Controls

The template for repeating rows also provides some tricks for colouring and borders that can
produce impressive results. The rules are as follows:

1. if a cell of a row inside a set of repeating rows has a background colour different to
that of the corresponding cell of the starting row (the row with the <<rr_xxx>>
element), then the background colour for that cell will alternate between that of the
starter row and it's own background colour. This allows everything from plain tables,
to alternating rows to crazy alternating patterns.

2. the starting row (the row with the <<rr_xxx>> element) determines the top border of
the first repeating row. The ending row (the row with the <<er xxx>> element)
determines the bottom border of the last row to be rendered. This applies on a cell-
by-cell basis as for the background colouring. This allows for highly configurable
borders to be specified that work pretty much as one would expect.

The following example creates a bounding border encapsulating all the repeating rows
(including the marker rows, and alternates the background colour.

Docmosis Example Template

Circle of Friends
Friend | Jah
arr_friendsn
Timmy has a friend called afriends afriendlobs
wer friendsn

Notice in the result below the alternating background colours and the border wraps all cells

collectively.
Docmosis Example Template
Clircle of Friends
Friend | Job
Jimmy has a friend called Dave Mdarketing Manager
Timmy has a friend called Dee CH Deweloper
Jimmy has a friend called Pete Roof Tiler
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Note

End markers for repeating rows can also be defined without the name. In the above example, the

field <<er_friends>> could also be simplified to <<er >>.

More advanced examples are given in section 2.9.5.

Sometimes alternating row colouring is not desirable. In this case, Docmosis templates can
disable the row colouring by using the <<noRowColouring>> (or <<noRowColoring>>)

directive. The following rules apply the scope of effect of the diretive:
1.

2.9.4 Conditional columns

A template may also indicate columns in a table that are to be conditionally removed. The
width of the table remains as fixed in the template and the space recovered by the removal

of the column is spread across the remaining columns. The following example shows a
Docmosis conditional column element (<<cc_showJobs>>) at the top of the second column.

Civele of Friends

wce showJobss |

Friend

Comtact

wrr_friendsy

Joh
[

Jimeny hag a friend called afriends

ufrrendloby

ifriendContacts

wer [riendss

if <<noRowColouring>> appears anywhere in a table, the alternating colouring is
disabled for that table.

If <<noRowColouring>> appears in the body text of the template (outside of any
table) all following tables will have no alternating colouring.

When rendered, this removes the column entirely where the data indicates that showJobs is

false.
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Circle of Friends

Friend Contact
Jimmy has a friend called Dave After hours
Jiminy has a friend called Dee ANV Tme
Tumeny has a friend called Pete Any time

The following example uses expressions to conditionally remove two columns from the table.

If you examine the Trial 2 and Trial 3 columns, you will see the conditional column

expressions in fields <<cc_{ntrials>1}>> and <<cc_{ntrials>2}>>.

Lab Results Trial 1 Trial 2
«cc_{ntrials>13}»

Trial 3
«cc_{ntrials>2}»

All Passed

«I1_specimens»

«name» «resultsl» «results2y

«results3y

«passed»

«er_»

If the underlying data says there is only one trial for example, that is, ntrials = 1 then the
conditions for the Trial 2 and Trial 3 columns will evaluate to false and the columns will be
excluded. This is shown in the following example output:

Lab Results Trial 1 All Passed
SP1A-2474 47.241 No
SP1A-2524 23.442 Yes
SP1A-3211 13.672 No
SP1A-3213 53342 No

If the underlying data says there are 2 trials, that is, ntrials = 2, then the Trial 2 column will
remain in the resulting document, but the Trial 3 column is still removed:

Lab Results Trial 1 Trial 2 All Passed
SP1A-2474 47.241 32,553 No
SP1A-2524 23.442 44,123 Yes
SP1A-3211 13.672 61.153 No
SP1A-3213 53.342 12223 No
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2.9.5 Advanced table structures

Docmosis supports the nesting of repeating and conditional content in table structures. The
following example template shows multiple levels of repeating to print out the room details
within each floor within each hotel.

w1 hotels»
Hotel «hotebs Location «locations
«tt_floosss
Floor «floors
Room # # Beds | Other Features
LY TOOETSE
aromtion enBerdzy ®  comFeatumes
£0T_EDOHSE
<ef_floorFows
wer_hotelRows
Footer

The example above is fairly extreme and it would often be more natural to represent the
structure in a combination of repeating sections and tables with repeating rows. The
following template is equivalent but is not providing the entire structure within a single table:

wrs_huotelss
Hotel «hotels in «locations
wrs_floorsn

Foot: efloors
Room # # Beds | Other Features
CIT_FOOmS
coombloz enbiedsy [ - —
£8T_TOCTISR

wes loores

wes_hotelse
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2.10 Lists

Docmosis infers repetition when there are one or more elements in paragraphs formatted as
a list using the ‘bullets and numbering’ features. As long as the data provider has data to
populate, the list will be rendered with items.

In the following example, a field is formatted as a humbered list and will be automatically
expanded.

List Expansion Exanple

These are my riends

1 wfriends[*] frends

An example of a list item.

Docmosis splits the element into two parts, a repeating component and a lookup component.
The repeating component can be limited by a using range specifier covering multiple values.
In this example, the range specifier [*] against the friends name means for all friends and the
trailing friend name is the lookup of the data to display.

List Expansion Example

These are my friends:

1. Dawe
2. Dee
3 Pete

As another example of how the field is split, consider the following template.

List Expansion Example
Idy birst friend afrends[F | frends has the Fellowing pets:

®  gfnends[F]pets[*].types
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The element now is in a bullet list style rather than numbered. It has a repeating
component friends[F].pets[*] meaning all pets of the first friend and a lookup component type.
The resulting document is shown below where the friend has a dog and a parrot.

List Expansion Example
Wiy first friend Dave has the following pets-

* dog
& parrot

Docmosis only allows a single component of the element to be a multi-valued range. For
example, Docmosis would not allow an element friends[F2].pets[*] since this would repeat at
multiple stages and typically would be a mistake.

To create a list:

1. Position the insertion point at the location of the first list item.

2. Format the paragraph as a list item (bulleted or numbered).

3. Add the Docmosis element that will render the data into the list paragraph.

2.11 Merging Templates Together

Docmosis has the ability to combine multiple templates into the resulting document. This
gives developers and template authors the ability to separate common content out of
individual templates and into a "shared" or common template. The common information
then only needs to be maintained in one location and all referencing templates will
automatically use the new information. Examples of use include company information
including logos for the header, contractual clauses and signature blocks for the body, or
even the specific content of the bottom left of the footers.

Templates used for inclusion can include all typical content including styled text, headings,
tables, images etc. Docmosis will populate the templates as per normal using the data that
applies at the point of insertion, as if it were content in the main template as opposed to
separated out. Any number of templates can be included, and included templates may
include other templates.

The way to control this is to insert a reference in your template to another template. The
referenced template will be populated and inserted at the referenced location. For example,
given a starting template MainProcess.doc that references two other templates process1.doc
and process2.doc, Docmosis will insert process1.doc and process2.doc into MainProcess.doc as it
processes MainProcess.doc.

Docmosis supports two ways of referencing templates; directly and indirectly. Each of these
is explained in the following sections.
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2.11.1 Direct Referencing

Direct referencing is very simple, the template to include is literally named in the reference.
The way to create a direct reference is to use a merge field prefixed with “ref:”. For
example <<ref:process1.doc>> will cause the template processl.doc to be inserted. The
following example shows how this would look in a template:

Docmosis Template Example

Template Merging Example
Our main process is detailedin the sections to follow.

wref-process1.docy

2.11.2 Indirect Referencing

The name of the template to include can be determined by the data, rather than by the
template directly. In this scenario, Docmosis will ask the DataProvider to provide the
template name.

To create an indirect reference, the field prefix “refLookup:” is used. For example, if we
created a field <<refLookup:process1>>, Docmosis will ask the DataProvider for the name of
the template under the key “process1”. The value the DataProvider returns will be used as
the name of the template to insert into the document. If the template in the example above
was changed to use an indirect reference as discussed, it would look like this:

Template Merging Example
Our main process is detailed in the sections to follow.

areflookuprprocessl»

2.11.3 Templates in Different Locations

Docmosis assumes by default the templates referenced existing in the same location (that is
the same template context) as the referring template. In our scenario above, processl.doc
and process2.doc must exist in the same place as MainProcess.doc. This works for small scale
use, but would quickly become unmanageable if there were a large number of templates in
use.
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For example, say the company banner information has been put into a separate template for
use in all documents, it would be unfortunate to have copies of this template everywhere.
Instead, there might be a single copy of the template in a common area for all projects and
templates to reference. Docmosis allows the templates to be referenced in any context
using the familiar path notation. Here are some example template references and what they

mean.
Field Description
<<ref:templatel.doc>> templatel.doc is expected to be in the same location as the calling
template.
<<ref:/templatel.doc>> templatel.doc is expected to be in "root" context . The root context is

the parent of all other contexts.

<<ref:/common/template1.doc>> templatel.doc is expected to be in the "common" context one down
from the root context

<<ref:../templatel.doc>> templatel.doc is expected to be in the parent context of the calling
template.

For example, consider a project “projectAlpha” which has its own templates and is stored in
the template context “projects/projectAlpha”. We want to include a common heading in some
of our templates, and so we separate that content into a separate template called
corporateHeading.doc. We realise that corporateHeading.doc applies to lots of other projects
and should not really exist inside projectAlpha itself.

We decide to create a common area to store the templates that are common to lots of
projects inside the context “common”. When all our templates are loaded into Docmosis,
the template store will look like this:

4 COMIMon

""""" headerContent.doc
4 projects

_:1 projectilpha

e mainfocument.doc

Templates such as mainDocument.doc Will be able to reference and include the template
headerContent.doc using the field <<ref:/common/headerContent.doc>> or the field
<<ref:../../common/headerContent.doc>>. The two fields just listed use a literal "ref:" lookup of the
template names; the same result can be achieved using the indirect "refLookup:" lookup if
the data provider supplies the appropriate value.

Note

If you are using Word for your templates, make sure the paths or folders you are using don't contain
spaces in the name. If so, the fields in the Word template will not work as desired (and Docmosis will
tell you so). If you really wish to have spaces in the names of paths and folders, then you will have to
use dynamic (refLookup:) fields rather than static (ref:) fields or use OpenOffice Writer for your
templates.
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2.11.4 When A Template Cannot Be Found

Docmosis treats a missing template as an error. During the rendering of a document, if a
template reference is encountered and the template cannot be found then an error will be
raised. Depending on Docmosis configuration this will either write the error into the

resulting document, or produce no document at all and raise a Java Exception (see section
7).

A template could make reference to a template that doesn't exist and still be functional if the
processing of that template does not try to render the missing reference. This could happen
if the reference was in a conditional section that always gets skipped, for example.

2.11.5 Limitations

There are some practical limitations to the ability to include templates. The following
sections cover the fundamental limitations.

2.11.5.1 Headers and Footers

The main (root) template defines the headers and footers that will be used throughout the
produced document. Any headers and footers in the included templates will be ignored.
This doesn't mean the content of headers and footers can't be determined by included
templates, but the presence and overall properties are controlled by the main template.

2.11.5.2 Performance

The flexibility and maintainability provided by the Docmosis template merging feature has a
small processing overhead at runtime. Since significantly more work needs to be done to
produce the final combined document it is not surprising that there is a runtime cost. The
impact will vary upon the numbers and sizes of included documents but in practice the
difference in practice is not expected to be noticeable.

2.11.5.3 Styling Limitations

There are some tricks to learn about styling with regards to including templates. One
example is where the included template has a Heading style for the first line. Depending on
the versions of OpenOffice in use, the Heading style may get dropped unless there is a
leading blank line first. This is fairly minor in practice, but something to be aware of. Most
of the time the behaviour will be as expected and so experimentation will only occasionally
be called-for.

2.12 Page and Other Breaks

Docmosis templates may contain several types of break including page breaks, column
breaks and section breaks. If the break is in your template it will appear in your rendered
documents unless you condition it out with a conditional section. If the break is inside a
repeating section it will be repeated each time your repeating section is displayed.
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d.

To allow templates to be more expressive, Docmosis provides several fields that can be used
to render a break, but without having to place the break literally into the template:

Field Description

<<pageBreak>> Insert a page break at this location in the document.

Docmosis Template Guide

<<columnBreak>> Insert a column break at this location in the document. This only
applies to templates that have a multi-column page layout.

<<pageBreakNotLast>> Insert a page break at this location in the document unless we have
finished repeating the current repeating section. This is only valid
within a repeating section.

<<columnBreakNotLast>> Insert a column break at this location in the document unless we have
finished repeating the current repeating section. This is only valid
within a repeating section and within a page layout that is multi-
column.

For example, a template section repeating person details and desiring to put each person on
a separate page could look like this:

Docmosis Example Template

«rs, people»

First Name: «firstName»
Last Name: «surnames
«pageBreakNotLast»
«es_people»
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3 Applying a Renderer

WY D w

To enhance the presentation of your documents, you can apply a “renderer” to the field.
This allows various changes to be made to the field including:

e changing the background colour (if in a table cell);
e changing the font style to bold, italics or underline.

e changing the text to be displayed

To associate a renderer with a field, you use the renderer qualifier with the name of the
renderer that is to be used. The Java code supplying the data will also be responsible for
supplying the renderer (which is described in the Docmosis Developer’s Reference). The

only requirement in the template is to associate the renderer with the applicable field. For
example:

{renderer=myrenderer}
The field with the renderer would look something like this:

<<surname {renderer=myrenderer } >>

Note

Remember, you don't need to use a renderer qualifier if you want a cell to be permanently shaded.
Renderers allow changes based on conditions that exist during document generation.

Tip
You can set the background colour of a cell with no data by using an element whose name has no
equivalent (and thus no data) in the application, or by using a field named dummy.

Important

To enable the qualifier to work, you must make sure that you edit the code of the field and not the
display name/result.

Important

Make sure there are no spaces in the field name or qualifier. Spaces may cause the qualifier to not be
recognised, particularly if using Word for the template source. If a space is required, use the
underscore character (_).
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3.1.1 Renderer Parameters

Renderers may also be passed parameters so that the same renderer can be given different
directives depending on the case at hand. For example, the following fields pass different
parameters to the renderer named myrenderer:

<<surname {renderer=myrenderer(‘strict’) } >>
<<surname {renderer=myrenderer(‘bold’, relaxed’) } >>

The first sends a “strict” parameter to myrenderer, whilst the second sends “bold” and
“relaxed”. myrenderer is written in Java code and may respond to these parameters as it
sees fit.

3.1.2 Built In Date Renderer

Docmosis has a built in date renderer which is available to all templates without requiring
any Java code. To use it simply reference a renderer named “date”. It will format the date
in the default format (dd MMM yyyy) or as indicated by a single parameter. The parameter
is in the format specified by the Java simpleDateFormat class which is described in the
Java API Specification. Some examples of suitable formats are shown below. The full
documentation for simpleDateFormat can be read on-line at
http://java.sun.com/reference/api/ and navigating into the J2SE version of your choice.

The date formatter applies to date-typed data as comes from Java objects or database
queries. If the data comes from textual data (such as raw strings, XML or JSON data) then
Docmosis will automatically try to parse the data into a date. If you are passing an unusual
formatted date via text, then you can tell the date renderer how to parse it by providing a
second parameter. For example:

Birth Year=<<birthdate {renderer=date(‘yy’, yyyy’)}>>

Would produce 2-digit dates (eg “70") after passing the birthdate data supplied as a 4-digit
date only (eg “1970").

The following example uses the built in date renderer to format a birthdate field into a two-
letter year format:

<<birthdate {renderer=date(‘yy’)}>>

To allow for formats that include a space, the underscore character (_) is transcribed
automatically into a space. This is done since fields cannot contain spaces when using Word
as the template source. To include an underscore, the backslash character can be used to
indicate that the underscore should be left as an underscore (\ ).

The table below shows some examples of date formatting:

Example Field Result

<<birthdate{renderer=date}>> 27 May 2009

<<birthdate{renderer=date (‘E_MMM yyyy') }>> Wed May 2009
(Cyyyy’) }>> 2009

<<birthdate{renderer=date (‘dd/MM/yyyy’) }>> 27/05/2009
(

<<birthdate{renderer=date

<<birthdate{renderer=date

‘ad’, "yyyy’) }>> 01 (and after parsing an input
date in YYYY format)
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The formats supported come directly from Java’s SimpleDateFormat class documentation:

Letter  Date or Time Component | Presentation DCES

G Era designator Text AD

y Year Year 1996; 96

M Month in year Month July; Jul; 07

w Week in year Number 27

W Week in month Number 2

D Day in year Number 189

d Day in month Number 10

F Day of week in month Number 2

E Day in week Text Tuesday; Tue

a Am/pm marker Text PM

H Hour in day (0-23) Number 0

k Hour in day (1-24) Number 24

K Hour in am/pm (0-11) Number 0

h Hour in am/pm (1-12) Number 12

m Minute in hour Number 30

S Second in minute Number 55

S Millisecond Number 978

z Time zone General time zone Pacific Standard Time;
PST; GMT-08:00

Z Time zone RFC 822 time zone -0800

3.1.3 Built In Boolean Renderer

Docmosis can format boolean (true/false) data into several presentational styles using the
built-in “boolean” renderer. This renderer exists since true/false can often be better
displayed in a document by Yes/No, Y/N, tick/cross etc.

The built-in Boolean render takes a single parameter indicating the way the true and false
values should be displayed. The following table lists the built in values that may be passed
as a parameter.

Parameter Effect

No parameter true is rendered as "true" and false as "false"

"yn" true is rendered as "Y" and false as "N"

"ynlc" true is rendered as "y" and false as "n" (lower case)

"yesnouc" true is rendered as "YES" and false as "NO" (upper case)

"yesnolc" true is rendered as "yes" and false as "no"

"yesno" true is rendered as "Yes" and false as "No" (mixed case)

"wingdingsl"™ | trueis rendered as a wingdings tick and false as a cross

"wingdings2" true is rendered as a wingdings checkbox ticked and false as unticked

"dingbatsl" true is rendered as a dingbats light tick and false as a light cross

"dingbats2" true is rendered as a dingbats heavy tick and false as a heavy cross
Docmosis Template Guide Page 43
Version 3.2

Sep 2014



Docmosis Template Guide

For example, to use the yn Boolean renderer, a field may attach a renderer named
“boolean” and give it the ‘yn’ parameter:

<<isRetired {renderer=boolean(‘yn”)}>>
which will render true as v and false as N.

The Boolean renderer will also try to parse textual data into a Boolean value to allow a
renderer to control the way it displays. For example, t, y, yes, and 1 are all considered
“true”.

3.1.3.1 Using the Wingdings Boolean Renderer

The wingdings renderers are unlike the other forms of renderers in that they rely on the
template field actually being in the wingdings font in the first place. This means you would
create the fields as required:

Identity Provided

Passport | «hasPP{renderer=boolean(wingdings1’)}»
Driver’s Licence | «hasDL{renderer=boolean(wingdings1")}»
Residential Bill | <khasRB{renderer=boolean(‘'wingdings1')}»

Then change the font of the fields that are using the wingdings renderer to the wingdings
font:

Identity Provided

Passport | * =2 S«R--@0m e 0mn0d4H0
O SHE ¢ X WY 2 WY+ [~ QD
Driver's Licence | * 22 S«c@&ON mL0,0m Od 5,00
Ol SR b+ )MV L) MY, 4§D
Residential Bill | x2S+ E@OMN m2M ONOEHL0O0
Ol SHE o XMV DN MY+~ Q4D

When this document is then rendered, the renderer will place the correct wingdings
characters into the document.
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Identity Provided

Passport | *
Driver’s Licence
Residential Bill | *

x

Important

Using specific fonts may cause issues if you then migrate your system to another platform. You should
alwaysd confirm the operation of your template in all its intended system environments.

To insert a formatted boolean value element:
9. Insert the element using the basic element procedure (see page 19).

10. When you are happy that the element is correct, select it and format its characters using
the font you require for the resulting symbol.

11. Work with the application developer to ensure that the Docmosis data formatter returns
the appropriate character values for the true and false conditions.

3.1.3.2 Using the Dingbats Boolean Renderer

The Boolean renderer also provides the ability to render dingbats character replacements.
Using dingbats does not require any changes to fonts in the templates as is required for the
wingdings formatter.

You may find that Word does not understand the dingbats characters, so if you choose Word
as the output document type, you typically would not use dingbats character renderers. The
dingbat Boolean renderer can be used with Word or Writer templates, the effect is only an
issue in the output document. Built In Number Renderer

Docmosis can format numeric data to display in different formats.

Given numeric data (even if from a text source like XML), you can render it in different ways.
Assuming your data for myVal was “1.23", the following table shows what different number
renderers would produce:
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Example Field Result

<<myVal>> 1.23
<<myVal{renderer=number (‘'0.0") }>> 1.2
<<myVal{renderer=number ('$0.00") }>> $1.23
<<myVal{renderer=number (‘0.0EQ0") }>> 1.2E0
<<myVal{renderer=number (“###.###’) }>> 1.23
<<myVal{renderer=number ('000.000") }>> 001.230

The formatting that is supported comes (directly) from Java’s DecimalFormat class

documentation:

Character | Location Localized? Meaning

0 Number Yes Digit

# Number Yes Digit, zero shows as absent

Number Yes Decimal separator or monetary decimal

separator

- Number Yes Minus sign

, Number Yes Grouping separator

E Number Yes Separates mantissa and exponent in
scientific notation. Need not be quoted
in prefix or suffix.

; Subpattern Yes Separates positive and negative

boundary subpatterns

% Prefix or suffix Yes Multiply by 100 and show as
percentage

\u2030 Prefix or suffix Yes Multiply by 1000 and show as per mille
value

X Prefix or suffix No Currency sign, replaced by currency

(\uO0A4) symbol. If doubled, replaced by
international currency symbol. If
present in a pattern, the monetary
decimal separator is used instead of
the decimal separator.

' Prefix or suffix No Used to quote special characters in a
prefix or suffix, for example, "'#'#"
formats 123 to "#123". To create a
single quote itself, use two in a row:
"# o"clock".
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